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JUMP START !

- Connect each output of the Interface(s) as a speaker feed

- Authorize your Harddisk with the Installer

- Copy the “Sigmal Mixer v1.8” into the “Plug-Ins” folder

- Copy SIGMAL1 onto your Harddisk

- Launch SIGMA1

- Load one of the DEMO-SIGMA1-Sessions

- Add your favourite ProTools-Sessions if you like (v3.x/4.x/5.x)

- Load any combination of sessions and session tracks into the Inputs/Auxiliaries
- Push the Play button and hear the tracks moving

- Open the Input window, insert your favourite Plugins

- Stop by clicking again on the Play button (<spacebar>)

-Now read the manual how to place speakers, record movements ...

Panning System Specs

» Panner resolution temporal 10 ms

» Panner resolution spatial 10 bits with ramp interpolation

* Full 24 bit path, 16 bit and 24 bit files can be mixed

» Matrix size max. 32 in x 24 out +24 Auxiliary Inputs = 792 audio channels !

» Extremely DSP efficient through proprietary TDM Matrix Mixer (see above...)

* Free definable panning laws between arbitrary speakers

* Independent Layer of Volume and Plugin automation besides PT session
automation

» Simultaneous Real Time panning of up to 32 sources to 24 outputs
( for actor tracking, virtual reality etc.)

* Integrated Surround Sound Monitoring ability (see chapter “Configuration™)
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1) WHAT IS SIGMA1 ?

With the growing importance of multi-channel audio systems in cinema , theatre,
music, theme parks ...  1fills the gap of a "spatial mixer” in the surround sound
production chain, supporting any current surround sound format. With its possibilities
and flexibility > 1 is prepared for future multi-channel sound formats supporting up to
24 individual full bandwidth channels. } 1 is also designed for science and research
in multi-channel audio systems as used for example in Virtual Reality simulations.

The main goals during development were:

* to design a system to handle easily the huge amount of channels in a multi-channel
surround sound production system

» graphical representation of the automatable movements of the sound sources
including free placeable "virtual loudspeakers"

* no limitation of the system by not committing to the current surround sound
formats, combined

with the highest flexibility to support any multi-channel sound format with up to 24
discrete output channels

* possibility of precise control over the sound distribution algorithm and access to all
concerning parameters to provide any imaginable multi-channel panning law

* to use the worldwide industry standard hardware platform including the use of all
available TDM

DSP-Plug-Ins to avoid confronting the user with another new and expensive
hardware system

» combination of user experience, different sound distribution - and room simulation
theories in

one program



The result is an architecture that is still unique to the digital audio world. >1
implements a graphical sequencer interface to record and play back "sound paths" in
space, controlling all necessary level parameters for you, based on a 32x24 Matrix
Mixer architecture with dynamic level automation in every crosspoint.

> 1 runs on the Digidesign® ProTools® PT24/PT24Mix hardware platform (PClI ).
Using the ProTools® TDM hardware platform offers you first a professional digital
audio system with all its capabilities and second, a totally new approach of a
multi-channel sound distribution system with integrated features like the famous
TDM Plug-Ins !

> 1 runs as a standalone DAE™-aware application (like Studio Vision, Logic Audio
etc.) controlling the 32x24 proprietary TDM Matrix Mixer, which expands your
ProTools system from the disk-based recording system to a 792-channel 32x24
dynamic matrix system.

What does Y1 do with 792 audio-channels ?
Let's explain this regarding a 7.1 (L/LC/C/RC/R/RS/LS + Sub) Surround production:

If you have to realize a individual level distribution of one input source with a
conventional mixing desk supporting 8 subgroups, you can do this by routing the
input to all 8 subgroups and adjusting the level relations with the subgroup faders.

If you want to distribute now two or more input sources for independent placements
in space, you have to move your distribution concept from the subgroups to the
inputs: for every input source you need 8 input faders assigned in parallel and routed
to the subgroups 1-8 to adjust different levels for every subgroup output.

The faders of the subgroups affect now the summation of all the input levels.

For each additional distributed input source you need 8 more input faders.

The whole amount of input channel is therefore determined by :

" Number of sources " x " Number of Surround Format outputs " = " Number of
input channels "

This 7.1 Surround production example would need a mixing desk with at least 128
input channels for simultaneous access to 16 sources.

In addition you would need at least a snapshot automation to control and edit all the
level- and routing informations.

For simulating a moving source you even need a more sophisticated dynamic mixing
desk automation for the level distribution, which still gives you a very abstract
interface (a lot of faders !) for the movement definitions.

You can imagine, that a complex dynamic movement control of multiple sound
sources would need a huge amount of time and equipment even with a high-end
conventional mixing console.

> 1 provides you with a dynamic sound movement control for up to 32 sources
distributed in up to 24 outputs with a specialized "roomoriented" user interface.

It is the first time that you are able to handle the simultaneous sound distribution of
such a huge amount of channels in a creative, ergonomic and useful way.



"Roomoriented” User Interface

The main window of } 1 displays a two dimensional view of the actual room situation.
Inside this window you handle the placement of the loudspeakers and the recording
and editing of the spatial positions and movements of the sound sources.

The sound movements are recorded to timecode simply by moving the Mouse or
using MIDI peripherals like Joystick, Dataglove etc. .

Also a PICT of the room situation can be put undernearth the surface for exact
speaker positioning and movement creation.

In addition to the realtime recording > 1 lets you calculate line- segments,
circle-segments and randomized movements.

You are able to define movement offsets in time and space, copy existing
movements to other channels or overlay them with a random function.

Concept of free defineable panning laws

The unique concept of free defineable panning laws between the individual speakers
frees the user from the limitations given by the usual surround sound formats and
their implementation in current mixing consoles.

For the first time Y 1 provides a creative tool for working with sound in space, no
matter what multichannel-surround-format, leaving conventional mixing desk
approaches for surround sound production far behind.

The Panning Laws (level distribution) are calculated by two parameters :

a) the distance between the mouseposition and the center of the speaker image on
the screen
b) the angle of the mouse location related to the main direction of the speaker

The relation between these two parameters and the resulting output levels are free
definable with graphical table editing.

The level distribution values are calculated with a ramped 10 ms resolution.

The resulting control level areas of the speakers can be calculated and projected as
colored level

areas to the screen, which implements a totally new and precise graphical
panning/volume control.

The Digidesign® TDM-Architecture

> 1 reads ProTools® Session files (Tracks and Volume automation data) which
allows you to work

with previously prepared time and volume structures of the individual tracks or
external inputs

(analog or digital).

All available TDM Plug-Ins can be inserted and automated in the Input, Auxiliary and
Output channels (simultaneously visible), which gives unprecedented flexibility in
assigning and moving sound effects in space including the simulation of virtual room
situations.



2) SYSTEM REQUIREMENTS

Knowledge of Pro Tools environment
MacOS 8.6 or higher

Pro Tools d24 + MIX Farm

Pro Tools MIX

Pro Tools MIX Plus

OMS v2.3.8 or higher

Quicktime Video: Digidesign approved card (currently Fuse, Miro DC30,
DV)

min. 192 Mbytes of RAM
G3/G4 CPU recommended

3) CONFIGURATION
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When launching SIGMAL the first time the Mixer Engine lets you choose a Matrix
Size you want to work with. The bigger the matrix configuration the more DSP power
is needed (see Appendix). You need of course two (16 outs) or three (24 outs)
Digidesign I/O Interfaces for bigger output configurations.

Note that the the same amount of Auxiliary Channels are created as Output
Channels are choosen. The Auxiliary Channels are layed out as DIRECT FEEDS to
the Output channels thus working as DUBBING Inputs (also known as Effect Returns
on conventional desks) which are summed into the Matrix outputs (pre fader, pre
inserts) . So Auxiliaryl feeds Outputl, Auxiliary 2 feeds Output 2, Auxiliary 3 feeds
Output 3... (see below about “Dubbing”).

Also you can choose between a 32 or 64 voice playback engine (only “MIX”
Hardware). Working with big matrix sizes and using the “Auto Dubbing” function with
two or more Pro Tools sessions simultaneously, mostly needs the 64 voice playback
engine.

For changing the playback engine or the Matrix Size during a session choose the
“Mixer...” menu, then save and relaunch SIGMAL to get booted with the new
configuration.

HINT: For professional 5.1 (7.1) Surround Mixing use a 16 output configuration
and use the first 888/882-Interface for monitoring and the second Interface for
the actual mix. This is easily achieved by placing the relevant virtual speakers
of the first and second interface at exactly the same positions (see below how
speakers are positioned and monitoring groups are built!).

For the monitoring I/O Interface all Output Window features
(grouping/mutes/solo/automation etc, see below) can be used to achieve a
highly sophisticated monitoring system solution within SIGMAL1 !

For 16 channel output the “Y” - cable for connecting two Interfaces at the first
card is highly recommended as this frees one DSP-Chip on the Mix Cards.



4) GETTING STARTED

After loading SIGMAL1 for the first time you will have to get familiar with a few
windows that will make your future “Surround Sound Production Life” easier:

The Session Bin
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The Session Bin lets you organize and examine your ProTools sessions which are
currently loaded into the SIGMAL1 memory.

You can load as many PT sessions (v3.x/4.x/5.x) as you like and memory permits.
Finder like click operations let you navigate through the list of Session Tracks and
Session Regions.

Just Drag&Drop your selection of ProTools sessions onto this window and all
associated sound and movie files are loaded into SIGMAL.

This also works by dragging PT Sessions onto the -| application icon.

All associated files and regions will appear in the Region Bin (see next window).



The Region Bin
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Once your ProTools sessions are read in all associated regions and files appear in
the Region Bin (alphabetically).

Clicking the blue triangle shows the actual path where the files/regions are located.
To include other soundfiles to the already loaded PT sessions just Drag&Drop
arbitrary soundfiles (SDII/AIFF) onto the Region Bin Window.

Drag any region/soundfile from the Region Bin into any Playlist Window of
individual tracks (see below) to create new or modify existing playlists.



The “Input Window” (<Command><1>)

NOTE: Without placing at least one speaker and creating at least one Path
inside the Stage Window (see below) you won’t hear any of the channels of the
Input Window.

Depending on the chosen Matrix configuration in the “Mixer Engine” dialog (see
above) the Input Window has 16, 24 or 32 channel strips.

The Input channels are the source tracks (“Paths”) for the Surround Sound Matrix
which are graphically moved/positioned inside the Stage Window.

The paths/positions are created inside the Stage Window by using the -
key (asterisk) and the mouse (see below).

By clicking on the input selection button (“none”) you’ll get a popup menu with
submenus which lets you choose between :

a) LIVE Inputs (882/888/ADAT Interface inputs, previously defined in Hardware
Setup))

b) > 1 playlists (see below)

c) A list of already loaded Pro Tools sessions (see “Session Bin” above)



Note that the currently active Input selection is always marked with a dot in front of
the pop up selection.
This is also true for the submenus in the popups.
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The picture below shows the selection of 888/24 Interface input 4 for a clicked input
channel .

none

1 583/24
Z1 Sezs=ion Playlist M Zz zERizd

® PT Session M = s85/24

5 gelkizd

& B28/24

T 888/24

& _S55/24




The picture below shows the selection of one of a list of loaded Pro Tools sessions

(see Session Bin).
(“Session MIX1" is the already active PT session and the “krumme startzeit” PT session is added to

Group A))
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Using the “Load...” command removes the currently selected sources in ALL
Input channels and loads a complete new Pro Tools session starting at Input
Channel 1.

Using “Load to Group “ adds a Pro Tools session ONLY to those channel
strips which were previously assigned to the specified group (see below). All
other channels keep their track assignments. This for example is a very
comfortable way to merge two Pro Tools sessions into one.

Note that the Input Window is completely independent from the Auxiliary
Window. So loading, exchanging and removing PT Sessions/Inputs/Playlists
does not affect the channel assignments in the Auxiliary Window.



The picture below shows the exchange of one track of a selected ProTools session
with a track of another Pro Tools session

(“Session MIX1" is the already active PT session and the track “Audio 16" of PT session “Harley
Atmo” is used instead of the originally loaded track.)
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If the user wants to use one or more favourite tracks of a different PT session
inside the current one, just go to that session and that specific track in the pop
up menu and select it for exchange into the clicked channel.

This of course includes the exchange of fades and volume automation for that
channel in the PT layer of the automation (see below).
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-->Two Layer Automation

When loading a Pro Tools session the volume automation data (and the Plugins
positions and presets if selected) for each session track is read by SIGMAL.

The > 1 button lets you switch between the automation layer of the Pro Tools session
(PT) and the independent automation layer of SIGMAL1 (default).

Each layer has READ/WRITE/TOUCH/none automation functions.

The modes of the Y 1 layer of the automation are used for the TDM Plug-In
automation (see “--> how to automate TDM Plug Ins” below).

The automation Touch Release time is about 1000ms. Using the MotorMix hardware
interface allows a more sophisticated use of the Touch mode (see Appendix).

Note that also the Mute states in each channel are automatable !
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Doubleclicking the “Path x” labels opens the “Track Info Window” which lets you set
important channel strip specific functions (see below).



The “Auxiliary Window” (<Command><2>)
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Depending on the chosen Matrix configuration in the “Mixer Engine” dialog (see
above) the Auxiliary Window has 8, 16 or 24 channel strips (always the same
amount as Output channels choosen in the “Mixer Engine” Dialog).

The Auxiliary Channels are layed out as DIRECT FEEDS to the Output channels
thus working as a DUBBING Input (also called Effect Returns on conventional desks)
which is summed to the Matrix outputs (pre fader, pre inserts) .

So “-->1" adds to Output 1 in the Output Window, “-->2” adds to Output 2, “-->3”
adds to Output 3... (see below more about “Auto Dubbing”).

All input selection possibilities and automation modes described in the Input
Window section also apply to the Auxiliary Inputs ! (see above)

Note that the Auxiliary Window is completely independent from the Input
Window. So loading, exchanging and removing PT sessions/Inputs/Playlists
does not affect the channel assignments in the Input Window.



The Auxiliary Window is primarily thought as a “Dub Mix” Input for layering
complete PT Session submixes inside SIGMA1 with the matrix outputs .
Another main usage is for “placing” specific tracks or effect returns statically
in distinct output channels for blending with the matrix output result (see
below more about “Auto Dubbing”).

Doubleclicking the “--> x” labels opens the “Track Info Window” which lets you set
important channel strip specific functions (see “Track Info Window” below).

-->Dubbing/Auto Dubbing:

Example Film Project:

PT Session1(PT1) -> contains all voices

PT Session2(PT2) -> contains all ambiences

PT Session3(PT3) -> contains all music

PT Session4(PT4) -> contains all multi-language takes

Assumed you have loaded a 5.1 setup in the Stage Window:

STEP A)
Load PT1 in the Input Window -> Mix PT 1 to 5.1 -> Record to 5.1 PT session in the
Output Window (Result: Out_Session.1)

STEP B)

Load PT2 in the Input Window AND Load Out_Session.1 in the Auxiliary Window ->
Mix PT 2 AND Out_Session.1 to 5.1 -> Record to 5.1 PT session in the Output
Window (Result: Out_Session.2)

STEP C)

Load PT3 in the Input Window AND Load Out_Session.2 in the Auxiliary Window ->
Mix PT 3 AND Out_Session.2 to 5.1 -> Record to 5.1 PT session in the Output
Window (Result: Out_Session.3)

STEP D)

Load PT4 in the Input Window AND Load Out_Session.3 in the Auxiliary Window ->
Mix PT 4 AND Out_Session.3 to 5.1 -> Record to 5.1 PT session in the Output
Window (Result: Out_Session.4)

Selecting “Auto Dubbing” in the Setup Menu even automatically loads the
created Pro Tools “Out_Sessions.x” into the Auxiliary Inputs after each pass.

The example shows how to build an arbitrary layered MULTICHANNEL
Surround Sound production with individual Pro Tools sessions.

The approach is comparable to the good old (Two Channel-) “Ping-Pong”
recording method but with ProTools sessions as the sources !

This way also allows easy going back in the production chain a few steps and
redo things a few layers earlier.

Each of the so created PT sessions can of course also be loaded into Pro
Tools for further editing !






The Playlist Window
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Doubleclicking onto the input selection button in the INPUT Window opens the
Playlist Window of that channel (either a ProTools session track or a 1 Session
playlist ).

The Playlist Window lets you navigate through and EDIT the currently active Playlist
of that channel.

HINT: Doubleclicking on a already positioned Input Channel icon @ in the
Stage Window (see below) also opens the Playlist Window of that channel.

By clicking onto a region name the starttime of the “Transport Window” is
automatically set to that time. This is especially useful for recording sound
movements related to individual regions.

<Option> clicking onto a region name also sets the end time inside the transport
window which for example is very useful in Loop mode or for having exact matches
of movement starts and ends.

Using the TAB key moves the starttime to the next region in the row.
Using the <Shift>TAB key moves the starttime to the previous region in the row.

Clicking inside the Start Time gets the time highlighted.

Choosing the appropriate hr:min:sec:fr column lets you change the starttime of that
region.

If a playlist has been changed, when quitting SIGMAL1 you will be asked if you want
to save that new playlist inside the saved 1 Session.

The readout on top of the window shows the channel name and the bit depth of that
playlist.



Additional regions can be inserted/added by dragging them from the Region Bin
inside the Playlist window

There are two modes for putting regions/files inbetween existing regions:

INSERT: (default): If the region inserted between two regions is longer than the gap
between them, the length of the inserted region is cut to fit into that gap.

ADD: If the region inserted between two regions is longer than the gap between

them, all subsequent regions are moved for the additional amount of time that is
necessary to get the complete new region placed between the two regions.

The Track Info Window
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The Track Info Window lets you handle track specific information of the Input,
Auxiliary and Output Channels.

For the Input Tracks the window is splitted in two parts:

The upper half lets you manage “Sound Movement/Positioning™-related settings, the
lower half lets you manage the global Offset for that track, switch individual Plug-In
inserts Pre or Post Fader and rename the current track.

“Do for all” does the action for either all Input, Auxiliary or Output tracks, depending



on which Track Info window type is opened.

The upper row buttons let you delete either all Soundpath-Movements in the
selected track or delete them from the current start time until the end (visible in the
Transport Window or Stage Window Clock).

“Do for all” lets you delete all Movements in ALL Tracks (good for cleaning
everything before working). Be careful with it!

The “Enable Record Offset” checkbox allows to define a x/y offset in Pixels for that
track.

This is especially useful when recording the movements of grouped (stereo or
multichannel) sources at once !

---> How to move grouped channels at once

In a Input channel click on the button above the 1 icon. With the popup you can
assign this channel to a group (so lets use Group A for thisexample).

Assign all Input Channels you want to be grouped to group A the same way as
before.

Then Doubleclick on the "Path x" label of that track .This opens the Track Info
Window. Here you can select Track specific functions (upper half movement related,
lower half audio related).

Checking the Group button here relates the Movements to the previously defined
Group A. With the popup menu in the track window you can go to the desired tracks
and also group their movements.

Now whenever you move one of the Grouped paths all other associated paths are
moved also.

Now all sources are positioned at the same x/y coordinates. You would see only one
5 ] Input Channel Icon lying above the other grouped tracks.

If you want to position for example your grouped tracks side by side with some
distance inbetween, check the "Enable Record Offset" button.

This allows you to define a specific x/y Offset (in Screen Pixels) for each path.
Selecting for example +25 Pixels x offset for path 17 and +50 Pixels x offset for path
7 results in a simultaneous movement of three channels side by side.

o b @



SHORTCUT !

1) Group the Input channels (see above).

2) Place the “masterpath” with the asterisk-key in the Stage Window.

3) Doubleclick the “Path x"-label of the “masterpath” to open the track info dialog.

4) Check the “Group” checkbox.

5) Use the popup to select the next path to be grouped

6) Push the < G > key (for “grouping”).

7) Now you see the x / y offset of the mouseposition in relation to the “masterpath” in
the corresponding displays.

8) Moving the mouse while holding the < G > key allows easy graphical offset
definition for grouped paths.

IMPORTANT: Setting X /Y offsets needs at least one existing path in the Stage
Window

---> How to loop movements

In the Track Info window check the loop button. Now this Path will loop between the
first and the last movement you made on this channel.

---> How to lock movements

In the Track Info window check the lock button. Now this Path will be record safe to
tp prevent accidental overwriting of previously made movements.

---> How to use the “Mute at End” function

With Mute at End you can define for every Input Channel the behavior after reaching
the end of a Movement : If Mute at End is checked the Channel will be muted at the
stop position of the last movement during replay. Otherwise the Channel remains
open at the the last Movement position (Default).



The picture below shows the smaller Track Info Window of the Auxiliary channels
(same layout as Output Track Info)
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On the top you find a track selection popup that lets you easily navigate between the
channels

The “Transport Window” (<T>)
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The Transport Window is divided into two sections (from bottom to top) :

» The Transport Controls are much like a conventional tape transport and provide
control for (from left to right) On-Line (Sync to incoming Timecode), Global Loop
(between Punchin/Punchout Times), Return To Zero, (Step-)Rewind, Play/Stop,
(Step-)Forward, Go To End , and Record Audio (16 or 24 bit) .

By < Option > Clicking on the Record button the recordings are saved as 24 bit

files/-Pro Tools sessions, no matter what format was used in the actual > 1
session !



* The Time Ribbon is used for very fast navigating to all Movements/Positions of
sounds. Here you adjust the start- and endpositions for Playback/Record as well
as for all time based calculations of the movements. Additionally you can define the
Stepsize used by the Rewind and Fastforward buttons by click dragging the
Stepsize to the desired value. Also you are informed about the current selected time
display format (ms = Milliseconds , f = Frames, switchable in the “Setup” menu).

There are three ways to navigate to the desired Start (Punch In) - and Endpositions
(Punch Out) of audio positions:

* Click and drag the mouse inside the green Time Ribbon to decrease or increase
the start- or endtime. You will change the start- or endtime depending on whether
you clicked closer to the start- or endposition.

» Clicking and dragging the mouse up or down in the appropriate time display to
increase or decrease this
value.

* Use the (Step-)Rewind/Forward buttons with the desired Stepsize

While clicking and dragging the Starttime or Endtime you will see simultaneously
moving in time:

* In the Stage Window: The track icons

* In the Input/Auxiliary/Output/Plugin Windows: All automated faders/buttons (if
automation is in READ mode)

* In the Movie Window : The current Quicktime Video frames

* If MMC is selected: After releasing the mouse button a connected MMC-Slave is
located to that time position (see more about the MMC Remote below).

After releasing the mouse button all related audio regions of that time point are
loaded to that starttime for later INSTANT playback.

When dragging the Endtime the current Quicktime frame and the position of the
sound source are displayed, thus being very helpful for navigating to the begin and
end of a selected scene and instant work inside that range.



The resolution of the Time Ribbon is adjusted with the Adapt Start-/Endtime
commands in the “Controls” menu or by < Option > Clicking onto the time display
boxes.

The upcoming dialog allows adjusting the borders of the time ribbon.

< Option > clicking inserts the current time into the appropriate time display box so
you just have to hit the OK button in the dialog:

Adapt Start/End Time

i i
ﬁ
[00:1z.00:00 |

[ Cancel ]

So, with the Adapt Start-/Endtime commands you can adjust the times, which
represent the most left and right edges of the Time Window you are working in .

Example :

Set any Startime greater than 0 seconds in the Transport Window. You will see a
black bar from the left to that position in the Time-Ribbon which represents the actual
start time. If you choose Adapt Start Time with this time, you will recognize, that your
starttime will not be affected, but the left side of the Time-Ribbon is getting again
green. Now the Time - Ribbon will start at this time. If you decrease the starttime by
editing the time values in the time indicator boxes lower than the Ribbon starttime,
the new starttime will automatically be adapted.

The End Time of the Time - Ribbon is adapted the same way.

Note that you cannot position the starttime before the TimeCode Offset already
set up in the “Timecode...” Menu.



The “Stage Window” (<Command><4>)
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---> How to prepare your speaker (Output) setup

After loading the program you can open the “Stage Window” by selecting it from the
“Window” Menu or by pressing <Command>< 4>,

Positioning Loudspeakers:
Either Click to highlight the speaker icon in the “Stage Window”,

Fath & I | Output 2 0% 0 283 <-= % : -12)

Lo w0 .'mﬂ---.-u’ﬁ

or push the <L> key on the keyboard, or use the appropriate command from the



Controls menu to change to LS Positioning Mode. The top readout changes from the
current “Path x” display to the “Output x” display.

Clicking the Mouse button places the current Loudspeaker (displayed in the top
readout of the “Stage Window”, default is LS 1) at that point. Clicking on another
point inside the Stage Window moves that speaker to that point.

The displayed speaker icons Q represent the Output channels inside the
“Output Window” which are identical with the physical outputs of the
Digidesign I/O Interfaces ( for example Output 9 here is the first Output of the
second Interface ).

To place another speaker use the <arrow up>/<arrow down>key to
increase/decrease the speaker numbers. All changes are shown in the top readout
of the “Stage Window”.

Clicking and dragging a speaker to a new position is also supported, making this
speaker the current selection (see readout).

Deleting a Loudspeaker (this means this output of the 1/0O-Interface is not active) is
done by using the <Backspace> key (deletes current speaker icon).

Besides the speaker number you find a readout of the current mouse position in
pixels.

Setting the Direction of the speakers:

While in LS Positioning Mode <Control> Mouseclick onto the Stage Window adjusts
the current speaker to the clicked position (the red dots are the 0 degree axis of the

virtual speakers).

<Shift><Control> Mouseclick sets the direction for all speakers at once to the clicked
point. This allows an easy way for setting up the "Sweet Spot” in your environment.

After completing your Loudspeaker setup push again the <L> key to return to normal
operation mode.

You can save now this setup as an individual LS setup with the Export LS
Positions... command in the File menu, or save it later together with all movements
etc. (see Appendix what else is saved) with the Save y 1 Session... command in the
File menu.

Defining Distance and Direction Characteristics:

The output level of each individual speaker relating to the position of the sound
source on the screen is defined by the two parameter tables:

* Distance: This is the distance in pixels between the mouse(source) location and
the center of the speaker image on the screen

* Direction: This is the angle of the mouse(source) location related to the main
direction(red dot) of the virtual speaker

The tables are graphically editable via the Coverage Tables... menu or
<Command><E>.



s |

424 Pixel -12.5 dB

Direction Attenuation

Distance-Table:

The X-axis represents the distance of 0-999 Pixels (a 832x624 monitor
diagonal).The Y-axis represents the volume of the virtual speaker in dB. For your
convenience steps are mapped to a decibel scale so the default "straight line” works
for a lot of standard applications.

With the drawing tools you can edit freely your distance setting. So if you want for
example a clearer separation between the speakers, draw your line steeper so that it

ends earlier on the -o0 dB level line.

Direction-Table:

Here the X-axis represents a circle around the virtual speaker from 0-359 degrees,
while O degrees relate to the main direction (red dot).The Y-axis represents the
volume in dB.

With this table you are able to manipulate the output level characteristics depending
on the angle of the source location.



This means that you are scaling the outputlevel characteristics of the Distance-Table
above with a directional value.

So the loaded Direction default table has no influence between 0-47 and 312-359
degrees on the Distance characteristics. Towards 180 degrees (this is "behind” the
virtual speaker) the level is continuously reduced up to -15,5dB and rises again until
312 degrees.

This is a very convenient way to define a output sensitivity area which actually
defines the "panning” between the speakers.

Displaying the Output Sensitivity Areas

After defining the virtual speaker characteristics you can display them as a colored
area representations. Each color represents a -3dB area ( red=0dB -> dark green
-21dB). The level transitions inside and between the areas are (of course)
continuous. To display the areas use the Calculate Level Areas command in the
“Stage” menu or press <Command><K>.

-6dE to 9dE -AdE to -12dE -12dE to -13dE

It is important to understand that the calculated level areas are not representing the
SPL (Sound Pressure Levels) in your real room because we have no knowledge
about the sound system behind } 1!

No mixing desk knows about the speakers behind it...

The colors are a graphical representation of the sound source’s output levels in each
virtual speaker ( i.e. the outputs of your 888/882-Interfaces) depending on the
relative position of those speakers.

If you have problems with the understanding about the characteristics it is
sometimes good to experiment with just one speaker on the screen.

---> How to record Movements (Realtime)

Source Channel state display in the Stage Window:

ﬂ Muted Channel

@ Active Playing Channel
E Current Record Channel
ih Current Preview Channel



FOR ANY ARBITRARY MOVEMENT/POSITIONING OF AN AUDIO SOURCE IN A
MULTICHANNEL SETUP YOU HAVE TO DO ONLY THREE STEPS :

1) Select the desired channel you want to position/move in the Input window

* by clicking on the desired Input channel (“Path x”) label

or

* selecting the “Current Channel:” in the Stage Window Popup

or

* use the keyboard up and down arrows to increase or decrease the channel number
or

* doubleclicking on a previously created Input channel icon @ in the Stage window

2) Adjust the start- and endtime (Punch In and Punch Out) for the following
recording with the time ribbon in the Transport window or click on the desired
audio region of the track’s Playlist (see Playlist Window above).

3) Go to the Stage Window, position your mouse where the sound source

should be placed and press the - key (asterisk) for recording the
position/movement.

Under the cursor you will see the RED record icon o of the current channel, the
play button in the Transport window changes to a red stop button and the time
display in the Stage window displays the current time.

Now all mouse movements (or other external control devices hooked to that channel)
will be recorded for that channel until the time reaches the PunchOut time (if

adjusted) or until you push again - key or the < spacebar> .

It is recommended to start recording movements always with the - key and not
with the record command in the Controls Menu, because your movements would
begin at the location of this menu.

If there is an audio input signal on that channel (how to navigate to a audio region
see above) you will hear the resulting movement immediately. Previously recorded
movements of the other channels are also played back during record. If you don’t
want to hear them mute/solo the appropriate channels in the Input Channel Window .

Recording Movements Details:

The most important thing for you to remember is the "destructive record insert
concept” of 1.

It always inserts a new movement record in a existing record. The previously
recorded movements which reside at the actual recordtime are erased and replaced
with the new movements.

Therefore make everytime sure that your actual recordchannel and
Punchin/PunchOut time is the right one before starting recording.



Start Time = Last Stop Time

Another handy feature is the “Start Time = Last Stop Time” option you will find in the
Controls Menu. With this option checked, the starttime is automatically set to the
time where } 1 stopped recording or playing back. This feature allows you to record
longer movements in sequencial steps without editing the Punchlin time at every
record start.

Remember the insert concept :
Without “Start Time = Last Stop Time” stopping and recording again causes > 1 to
overwrite the previous recorded movements beginning from the actual Punchin time.

Preview :

The Preview mode is a non destructive rehearsal mode of Record.

This means preview has the same behavior like record but the movements are not
recorded.

To enter or leave the preview mode push < option> <asterisk> or choose Preview
from the Controls Menu.

With the preview mode you can easily test different positions in space to find out a
optimal position.

Because the preview mode doesn’t record any data, you can use it also in live
situations without any timelimit.

This mode is also necessary to move simultaneously up to 24 sources with
attached MIDI joysticks (see below) !

---> How to calculate/edit/erase Movements (non-Realtime)

The Time - Ribbon is designed to provide two main functions:

* Controlling the Start- and End-Time (Punch In and Out) for realtime recording and
playback
* Controlling the Start- and End-Time for movement calculations, deletions and edits

You can adjust the start- or endtime by editing the time values in the time indicator
boxes, clicking and dragging the ribbon itself or with the (step-)forward and
(step-)rewind button. The time window inside which you are working is set with the
Adapt Start - /End Time commands (see more in “Transport Window” above).

* A black bar on the left or right side indicates a active Punch In or Punch Out Time
referring to ALL calculate functions

* A green right side informs you that there is no Punch Out (so for calculations you
have to specify one).

All calculate functions (including Cut/Copy/Paste) are performed inbetween
the Punchin and PunchOut times (the green part of the ribbon) !



Line Movement Calculation :

You want to calculate a straight line movement for channel 5 from point A to B in 10
seconds, starting at 5

minutes :

- 1) Select Channel 5 by clicking on the channel label (or use the arrow up/down
keys)

- 2) Adjust the Starttime to 00:05:00:00 (or click on a appropriate audio region in the
Playlist window)

- 3) Adjust the Endtime to 00:05:10:00

- 4) Shift-Click in the Stage Window where point A should be (Startposition of the
movement). A dialog follows where “Start Point” is already selected, then push the
ok button.

Define this point as :
i Start Point

StopsCentre Point

Circle

Deqrees

L3
|Eﬂncell | 0K I

In the Stage window the red record icon o indicates your defined Start Point.

- 5) Again Shift-Mouseclick in the Stage window now at point B (Endposition of the
movement). The upcomming dialog offers you now the Stop Point /Center Point
selection.

Press ok to start the movement calculation.

Define this point as :
i) Start Point

i Stop/Centre Point
[ circle

Deg reeh

|Eance|| | 1].4 I




Example for 20 counterclockwise circles in that time span:

Define this point as ;
{3 Start Point

) Stop/Centre Point
[ Circle

Degrees [-7200

| Cancel I

See examples for movement calculations in the window below:
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CUT/COPY/PASTE Movement Calculation:

The Copy Movement calculations can be performed with the usual
<Command><X>/<Command><C>/<Command><V>
shortcuts or selected from the Edit Menu.

- Copying into any channel (including same channel)
- dynamical offset copy

The first three steps are like usual :

- 1) Select the recordchannel you want to copy to.

- 2) Adjust the Endtime in the Transport window
- 3) Adjust the Starttime in the Transport window

— Paste Offset
{Start Point) — [+ End Point

‘
dx

d

FeA Time Scale [ | Randomize [] Urn

T

As you realize, with the Punch In and Out time you are able to copy every selection
of an existing movement !

- 4) Control Click in Stage Window : The position you clicked will be the startposition
of the copied movement.

> 1 will search for the nearest point of all recorded movements, takes the
corresponding channel as default and calculates the resulting x and y offset to that
channel.

You will see these offsets in pixels in the Copy Movements dialog box (see above).

You can change the channel you want to copy from with the pop-up menu at the top,
but not the channel you will to copy to ! (for this leave the dialog with cancel and
select the desired record-channel in the Transport Window).

For every source channel you select } 1 calculates the appropriate x and y offsets.



Start and End Offset :

By default the Start and End Offsets are equal which results in a static offset for the
whole copy. Changing the End Offsets will cause 1 to interpolate beginning with the
Start Offset (at adjusted starttime in the Transport window) and ending with the End
Offset (at adjusted endtime). As a good example try out what will happen here :

- Calculate a line movement for channel 1 of 10 seconds duration

- Copy channel 1 to channel 2 with a static offset (start same as end) of x=0andy =
- 50 (channel 2 moves parallel under channel 1)

- Copy channel 1 to channel 3 with : Start Offsetx =0,y =-50 ; End Offsetx=0,y
= +50 (channel 3 starts at the same position as 2 but moves across channel 1 after
5 seconds and ends at the same distance as channel 2 above channel 1 - ok ? -)

Delete Movements

---> How to record/export to Pro Tools sessions

There are two kinds of Pro Tools sessions you can create within SIGMA1.:
1) Using “Export...” in the FILE Menu:
Exports the Input Window/Auxiliary Window configuration to a ProTools session

This writes the current situation of the track input routing to a new ProTools session.
This is VERY useful when using different tracks of different Pro Tools sessions and
merging them into one session.

All automation of the used tracks is copied into the new Pro Tools session (forget
“Track Transfer”...).

No new audio files are created.

2) Bounce the Input/Auxiliary/Output Window Tracks to a Pro Tools session

-> Push the record enable button on the tracks you wish to record.

-> Push the Record button inside the transport window (starts blinking, <opt>
Record creates 24bit session!)

-> Push the Play button (or spacebar)

The selected audio files are recorded to hard disk and a Pro Tools session
containing these tracks is created.

If “Auto Dubbing” is selected the resulting Pro Tools session of the recorded
window is automatically time-aligned inserted in the inputs of the Auxiliary
window.

Hint:
The resulting Mix of the Output Window is recorded Pre Fader | Make sure to
not clip the matrix outputs by viewing the Output Meters Pre fader !



---> How to create new/modified playlists

Clicking onto the routing button (none) of a channel in the INPUT or AUXILIARY
Window lets you choose the source for that channel. When choosing “Y 1 Session
Playlist” the popup lets you choose to create a new one, delete the currently active
one (marked with a black dot) or select a previously created one.
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After pressing OK the user gets prompted with a empty playlist window.
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Playlist
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Insert I

RFegion Mame

Start Time

h

Duration
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Now drag any regions/file combination from the Region Bin Window into the new
Playlist window to create your desired playlist (all playlists can later be exported to

ProTools sessions).
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Duration

000007 22
00000110
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000001 21
000001 19
000001 24
000001 11
000001 18
00000020
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The readout on top shows you the channel name and the bit depth of that playlist.
There are two modes for putting regions/files inbetween existing regions:




INSERT: (default): If the region inserted between two regions is longer than the gap
between them, the length of the inserted region is cut to fit into that gap.

ADD: If the region inserted between two regions is longer than the gap between

them, all subsequent regions are moved for the additional amount of time that is
necessary to get the complete new region placed between the two regions.

---> How to insert Mono TDM Plug-Ins

> 1 gives you unprecedented flexibility in assigning and moving soundeffects in
space with the possibility of inserting all available TDM Plug-Ins in the Input ,
Auxiliary and Output channels.

For a quick access of the Channel Inserts use the shortcuts :

< command> < 1 > for the Input Window
< command> < 2 > for the Auxiliary Window
< command> < 3 > for the Output Window

or choose Input /Auxiliary/Output from the Window Menu.

Clicking onto the insert buttons lets you choose the desired effect:
A pop-up appears wich shows you all available Mono and Stereo TDM Plug-Ins:

no Effect

Mono  Effects 2
Steren Effects b

Selecting the desired Effect creates the connections for this Plug-In and brings its
Edit-Window to the front.



For full access > 1 allows you to let all Plug-In-Windows open at the same time.
The title of the Plug-In-Windows contains additional information to help you to
navigate through (sometimes lots of)

open Plug-Ins:

< Channel name > < Insert number from 1 - 5 > < TDM Plug-In Name in Window
title>

Output 4 FIns 1
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Focusrite® |
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Clicking the go away button of a Plug-In-Window only closes this window without
affecting the connections. To re-open the Plug-In-Window just click onto the
highlighted insert button in the appropriate channel.

To remove an Effect click the Insert Selector button and choose No Effect from the
pop-up menu.

If more than one Insert is used on a channel, the processing of the audio signal is
done hierarchically from top to bottom. You can add as many Plug-Ins as available
DSPs will allow. If you try to add a Plug-In Insert when the MIX Farms reached their
processing limits you will be informed with an error message.

All Plugins can be switched individually pre/post faders (note the pre button) !

You are able to add or remove Plug-Ins no matter if you are in play, record
(movements), preview or stop.

If you switch in Plug-Ins while Y 1 is playing back, it will stop the playback until the
new connections are ready and then continues playing back.



---> How to insert Stereo TDM Plug-Ins

Stereo Plug-Ins can be spread over arbitrary channels !

Inserting any stereo Plug-In the first time leaves the second channel free for inserting
in any arbitrary channel insert, even across Input, Auxiliary and Output channels
(advanced surround sound designers think of it!) :

no Effect

L1 limiter [Right) -=> [ Input Path 1 Insert 1 L1 limiter (Left) ]
Mono  Effects 2
Stereo Effects 4

The picture shows the popup menu when the left channel of a “Stereo L1 Limiter”
was already inserted into “Input Pathl, first Insert” and the right channel of “L1” is
still left free for arbitrary insertion.

The picture below illustrates a Stereo Reverb inserted in the “Input Path3” in Insert 2
with the left channel and in “Input Pathl” in Insert 2 with the right channel (note the
individual switchable pre/post buttons for each channel).
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It is important to realize the difference between using an Effect in an Input-, Auxiliary-
or Output Channel.

Effect in the Input Channel:

With an effect in the Input Channel you will process the moved/positioned signal of
this channel.

So this effect is moved in the same way through space like the input signal - the
inserted effect "follows” the movement of its Input Channel.

For example using reverberation in a Input Channel will result in a moving
reverberated sound!

Effect in the Auxiliary/Output Channel:

With a Effect in an Output Channel you will install this effect only for the
corresponding speaker(output). Setting up an effect in the Output Channel you are
able to affect indepent speaker parameters. For Example using different delay times
in the Output Channels to establish complex delay line structures for your current
speaker setup, or using equalization for one speaker to adapt different speakers
soundings in the room.

Using an Effect in an Auxiliary Channel will add this effect to the related
speaker(output).

Clicking on the <Factory Setting> button lets you import and save individual Plug-In
settings into the later saved ) 1 session !



---> How to automate TDM Plug-Ins

Clicking on the <Automation> button opens this dialog and lets you select the
desired automated parameter by just clicking on its name:

=
Enee = [ ]
Output Gain dB E
v Low Crossover Hz —
#  Mid Crossover Hz
v High Crossover Hz
Crossover [ =
Master Gain dB
HMaster Range -
» Master Thresh dB
Master Attack ms
Master Belease ms
# Band 1 Gain dB E

Clicking on a already checked parameter also unchecks it.

AFTER Clicking the OK button shows the checked parameter knobs/sliders
colored in the Plug In window (color depends on automation mode).

Hit the Play Button in the Transport Window and move the desired slider/knob
in the Plug-In window. That’s all.

The slider/knob’s movement will be later replayed at the same time location.



---> How to use the Dolby® Surround Plug-in :

Place 4 speakers in LRCS position:

L = Output Channel 1
R = Output Channel 2
C = Output Channel 3
S = Output Channel 4

Use the Plug-In Inserts in the Output Window.
Use for example the 4th and 5th inserts of the four LRCS tracks:

Insert 4.

L: Enc Master Left
R: Enc Master Right
C: Enc Slave Left
S: Enc Slave Right

Insert 5:

L: Dec Master Left
R: Dec Master Right
C: Dec Slave Left
S: Dec Slave Right

Moving a source track you will hear the complete Encoder/Decoder Chain.

For Lt /Rt Playback on the first two channels switch the Decoder to Bypass.
For hearing the “dry” signals (no En-/Decoding) also switch the Encoder to Bypass.

You can control the panning characteristics with the analyzing tool of the Decoder
Plugin.

We experienced that a steeper than default coverage characteristic of the
distance table works best for Dolby Surround. Depending on your production you
can optimize thesecharacteristics.

You can even use the original Dolby® Panner (which of course makes not so much
sense within Sigmal) for cross checking. Using the Dolby® Panner in a input
channel mutes that channel for the Sigmal matrix and routes the panned signal
directly to the encoder Plugin.



5) SHORTCUTS AND KEYCOMMANDS

Global shortcuts

-<Cmd > < 1 > opens Input window
-<Cmd > < 2 > opens Auxiliary window
- < Cmd > < 3 > opens Output window
-<Cmd > < 4 > opens Stage window
-<Cmd > < 5 > opens Locator window

-<Cmd > < E > displays Coverage Tables
-<Cmd > < J >toggles SMPTE sync on / off
-<Cmd > < N > creates new } 1 session
-<Cmd >< 0O >opens )1 session

-<Cmd >< S > saves )1 session

-<Cmd > < P > imports Pro Tools session
-<Cmd > < M > imports Quicktime movie file

- < Enter > creates Locator position
- < Shift > clicking on stage opens “Calculate Movement” dialog

Transport

- < T > brings Transport Window to the front

- < Asterisk > Record Movement/Position for current
Sound Object on/ off

- < Option > < Asterisk > toggles Preview Mode on / off

- < Spacebar > toggles Play on / off, stops record

- < Return > return to zero

- < Arrow up > increments current channel number

- < Arrow down > decrements current channel number

- < Arrow right > steps one stepsize unit forward in time

- < Arrow left > steps one stepsize unit back in time

- Clicking and Dragging the green timebar on the left half sets the starttime (
same as Clickdragging inside the timedisplay )

- Clicking and Dragging the green timebar on the right half sets the endtime (
same as Clickdragging inside the timedisplay )

- < Alt > Clicking on the time digit display allows numerical entry of the timebar
display resolution

- Clickdragging inside the stepdisplay ( ms or frames ) changes the stepresolution
used by the FFWD or RWD buttons or < Arrow left > < Arrow right > keys

- < Alt > Clicking on the REC button records the session in 24-bit format
- Clicking on the GTE button jumps to the end of all recorded movements



LS Positioning Mode

- < L > switches on / off Loudspeaker Positioning mode

- < Arrow up > increments loudspeaker number

- < Arrow down > decrements loudspeaker number

- < Mouseclick > places selected loudspeaker at cursor location

- < Ctrl > < Mouseclick > sets actual loudspeaker direction

- < Ctrl > < Shift > < Mouseclick > sets loudspeaker direction for all speakers at
once (“sweet spot”)

- < Backspace > deletes current loudspeaker

When launching SIGMA1

- < Ctrl > < Option > Launch SIGMAL1 Offline Edit Mode (no Digidesign Hardware is
aquired), handy for syncing OFFLINE to ProTools or to work on a Powerbook /
Laptop

In Track Info Window

- <G > Pushing the < G > key (stands for “Group”) displays the current mouse
position ( x /'y ) in relation to the previously defined “Master Path”

In Stage window

- Doubleclick on speaker icon Q opens coverage tables
- Doubleclick on track bullet @ opens playlist of that track

- < Ctrl > Doubleclick on track bullet @ opens track info window

-<Cmd > < C > copies movements of the current track between start- and stoptime
-<Cmd > <V > pastes the copied movements to the current track ( opens Paste
Offset dialog )

- < Cmd > Clicking on the stage after using < Cmd > < C > pastes a movement at
the clicked position ( without using the Paste Offset dialog. MUCH FASTER !!!)
-<Cmd > < X > cuts the movements of the current track between start- and
stoptime

-< Cmd > < K > calculates the level areas
-<Cmd > < T > toggles Path display on / off



Input / Aux / Output window

- < Alt > Clicking on buttons activates all buttons in the corresponding window

- Clicking on the Y1 button toggles between Pro Tools session automation and > 1
automation

- Doubleclicking on the Input Path or Auxiliary Out label opens the Track Info
window

- Doublecklicking on an activated Input label shows the playlist of that track (
same as doublecklicking on track bullet )

- < Alt > Mousedragging the faders allows grouped moving of all faders in the
corresponding window

- < Ctrl > Mousedragging allows temporarily ungrouped movements of an already
grouped fader

Coverage Tables

- < Cmd > Drawing with the mouse, the mouse behaves like a pencil, otherwise
always straight lines are drawn from the last to the actual clicked point.

Playlist window

- Clicking a region adjusts the starttime of the transport time ribbon to the starttime
of the region

- < Alt > Clicking a region adjusts the endtime of the transport time ribbon to the
endtime of the region

For selecting several regions first < Alt > Click for the endpoint, then Click on
the desired start region



6) QUICK REFERENCE (alphabetically)
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CALCULATE MOVEMENTS
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CONTROLS MENU
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MOVIE MENU
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SETUP MENU
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STAGE MENU
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7) PRESETS 5.1/7.1/10.2 etc.

8) APPENDIX

What is saved,loaded when and where?

Using the MotorMix hardware interface

Hint for Multi-Port Interfaces:

MotorMix uses always the FIRST MIDI port it finds in the OMS setup (Port names
are alphabetically sorted in OMS).

Please rename the MIDI port accordingly in the OMS setup so that the first port is
the one you want to use with MotorMix.

1) SWITCH the MotorMix to Standard Mode (NOT ProTools Mode)

2) With the “VIEW” buttons you can scroll in groups of 8 channels through the
INPUT-, AUXILIARY- and OUTPUT- Windows

3) Solo / Mute are in the same rows as written on the surface.

4) When using fader automation:

THERE is a SMART solution for those who cannot afford Touch sensitive devices...

-)
IN TOUCH mode:

When grabbing the fader to trim/overwrite an existing automation the LED in row
A..Z of that channels starts blinking.

This indicates an active write process to the automation and the fader motor is
disengaged.

When you are done with overwriting the new values just push on that blinking LED to
smoothly return to the previous recorded automation value.

For smoother start of auto touch you even can start your touch operation by pushing
the auto LED (which of course then starts blinking, indicating that the fader motor is
disengaged).

IN READ mode:

Exactly the same as above only the values are not written to the automation!

Thus the Fader motor is disengaged while the LED is blinking meaning that you are
now temporarily disable the read automation.

This is very handy for trying out different volume levels by hand without having to
disable the whole automation or overwrite the automation each time.

DSP usage on MIX cards

The 32 voices MixEngine (DAE) takes one DSP
The 64 voices MixEngine (DAE) takes two DSP

For configurations with 16 or 24 Outputs using a Y-cable is highly recommended as
this saves an additional DSP chip.



Matrix Size:

16x8 +8 Auxiliary Inputs ---> 2 DSP
24x8 +8 Auxiliary Inputs ---> 2 DSP 8 Output channels
32x8 +8 Auxiliary Inputs ---> 3 DSP

16x16 +16 Auxiliary Inputs ---> 3 DSP
24x16 +16 Auxiliary Inputs ---> 3 DSP 16 Output channels
32x16 +16 Auxiliary Inputs ---> 4 DSP

16x24 +24 Auxiliary Inputs ---> 4 DSP
24x24 +24 Auxiliary Inputs ---> 5 DSP 24 Output channels
32x24 +24 Auxiliary Inputs ---> 5 DSP
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